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Using SAAM II Writing Reports 

 
Writing Reports 

 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you how to create and save material to prepare 
reports. You will learn 
 

• How to use the Notes window (Part 1) 
• How to create and use text files (Part 2)  

 
Files Required 
 

Study Files: The study file for this tutorial is 
 

study_0.stu 
 

This file is included as part of this tutorial. This file is the same as study_0.stu 
that is installed in the SAAM II program folder and referred to in the SAAM II 
User Guide. 
 

Introduction 
 
This tutorial focuses on how to create material to prepare a report, and how to copy the 
material into other applications such as Microsoft Word®. All of the tutorials in the 
Using SAAM II series have been created using Microsoft Word® and by copying 
material created during a SAAM II modeling exercise into this application. 
 
A variety of techniques can be used. One is to copy tabular information to a spreadsheet 
application such as Microsoft Excel®. Data can be manipulated and then copied into a 
Microsoft Word® document. Another is to use the screen print capability or a software 
tool such as HyperSnap® which will allow you to capture portions of your computer 
screen. These can be saved, and then copied into a Microsoft Word® document. All of 
these were used in creating the Using SAAM II tutorials. 
 
The major options in SAAM II to create and save material for report writing are the 
Notes window, and saving information to a text file. The Notes window is accessed from 
the SAAM II Toolbar. This will be explained in Part 1. 
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Saving information to a text file is set up in the Computational Settings dialog box 
shown below: 
 

 
 
You can see the Save Results to Text File check box. When this box is selected, the 
options will appear as follows: 
 

 
 
There are three levels of information that can be saved, Basic, Detailed and All; each 
will be illustrated in Part 2. In terms of creating the text file, you can Replace the existing 
saved file or Add to it. These options will also be explained in Part 2.
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Part 1. Using the Notes Window 
 
The Notes window can be used to create and retain information of interest for a given 
model, such as a description of what is being modeled, comments on certain aspects of 
the model, a description of sampling techniques, etc. The Notes window is a standard text 
window and accepts normal editing. The contents of the Notes window are automatically 
saved with the model when you save the model. The Notes window may be left open 
while you are working on other parts of the model. 
 
This tutorial will show you have to save some material in the Notes window. What is 
illustrated is not exhaustive as you have many options. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 

 
a. The file study_0.stu should appear in the file list; if it does not, find the folder 

where you put this tutorial. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 

 
 

 

Rev. 11/01/05 ReportsUS-3 2003 - 2005 University of Washington 



Using SAAM II Writing Reports 

 
3. View the model and the experiment on the model. In the SAAM II Toolbox, click 

Experiment. The model of the experiment will appear on the Drawing Canvas 
as follows: 

 

 
 

This is the experimental model developed and used in the Getting Started with 
Compartmental tutorial.  
 

4. The Notes window – creating baseline information. 
 

a. In the Show menu, click Notes, or alternatively, on the SAAM II Toolbar 

click Notes . The Notes window will open as shown below: 
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The Notes window is simply like a note pad upon which you can record 
information. 

 
b. Type “Work with study_0 on January 1, 2003” as the first line of the Notes 

window. 
 
c. Solve the model. In the Compute menu, click Solve, or alternatively, on the 

SAAM II Toolbar, click Solve . 
 
c. In the Show menu, click Values, or alternatively, on the SAAM II Toolbar 

click Values . The Values window will open. Select the material as 
shown below: 

 

 
 
d. In the Edit menu, click Copy. Close the Values window. 
 
e. In the Notes window, line down and type “Baseline Solution”. 
 
f. In the Edit menu, click Paste. The Notes window will appear as follows: 
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Your Notes window now contains information about the baseline solution, i.e. 
the solution with the set of parameter values indicated, and the bolus injection 
also as indicated. Notice the initial value for q1 equals ex1.bolus; this is 
because “q1(0) = ex1.bolus”, i.e. the initial conditions for q1(t) are ex1.bolus. 
Similarly at time zero, q2(0) = 0 since there is no initial input into q2. There is 
no data “plasma” at time zero since there was no measured value at time zero. 
Finally, there are no values for s1_res or s1_wres since the model has not 
been fitted to the data. 
 
Leave the Notes window open. 
 

 Using Notes. You can record information about all your modeling activities in 
the Notes window. If you were to hand-fit the model to the data, you can 
record the values following each change in parameter values. You can copy 
information from the Table window into the Notes window. You cannot copy 
a plot into the Notes window. 
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5. The Notes window – saving information following a fit. 
 

a. Fit the model to your data. In the Compute menu, click Fit, or alternatively, 

on the SAAM II Toolbar click Fit .  
 
b. In the Notes window, type “Results following a Fit”. 
 
c. In the Show menu, click Statistics, or alternatively on the SAAM II Toolbar 

click Statistics . The Statistics window will open. 
 
d. Select and copy the material in the top pane of the Statistics window. The 

Statistics window will appear as follows: 
 

 
 
e. Return to the Notes window. In the Edit menu, click Paste. The copied 

material will appear in the Notes window. It is not possible to copy the labels 
of each column, so you will have to type them in yourself (as shown below). 

 
f. Return to the Statistics window, select and copy the information in the bottom 

page. 
 

g. Return to the Notes window. In the Edit menu, click Paste. The Notes 
window will appear as follows: 
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h. Close the Notes window. 
 

Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
 

The Notes window acts like a note pad. It is a text file into which you can type your own 
notes and paste information generated during your SAAM II modeling session. If you 
were to save your study file, your notes will be saved so the next time you open the study 
file, the notes will be there. 
 
You can also copy the contents of your Notes window into other applications such as 
Microsoft Word®. Notes are very flexible and helpful for keeping track of your modeling 
activities. 

 

Rev. 11/01/05 ReportsUS-8 2003 - 2005 University of Washington 



Using SAAM II Writing Reports 

Part 2. Creating Text Files 
 
SAAM II has the option of creating text files every time you Solve or Fit. There are three 
levels of information, Basic, Detailed and All.  A quick summary of the type of 
information contained in each report is shown below.  The reports will be explained in 
this tutorial since the level of information you need to write your report may vary 
depending upon the type of report you are preparing. 
 

SAAM II Save Results Options 
 

Information Type Basic Detailed All 
Study Information X X X 
Computational Settings X X X 
Experimental Attributes  X X 
Model Equations   X 
Data   X 
Exogenous Inputs   X 
Change Conditions   X 
General Model Information   X 
Parameter Values  X X 
Values at t=0.0 X X X 
Calculated Samples and Data X X X 
Statistics X X X 
Notes  X X 

 
 
You also have the option of over writing the text file after each Solve or Fit; this is 
helpful if you are concerned about using a lot of space, and don’t need the intermediate 
information. Alternatively, you can create a new file after each Solve or Fit; they are 
named in such a way that you can follow what you did sequentially. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 

 
a. The file study_0.stu should appear in the file list; if it does not, find the folder 

where you put this file. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 
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3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear on the Drawing Canvas 
as follows: 

 

 
 

This is the experimental model developed and used in the Getting Started with 
Compartmental tutorial.  
 

4. Turning on the Save Results option. 
 

a. In the Compute menu, click Settings. The Computational Settings dialog 
box will open as shown below: 
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The bottom pane of the dialog box contains the Save Results to Text File 
check box. If this box is checked, the Level and File panes become active. 

 
b. Select Save Results to Text File. The pane will appear as follows: 
 

 
 

The default settings are Basic-Replace meaning just the basic information is 
written to the file, and the file is replaced if you do another Solve or Fit. 

 
c. Click Done. 
 

5. Solve the model, and view the text file created. 
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a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 
b. Go to the folder where study_0 is located. In this folder, you will find a file 

entitled study_0.txt. The contents of this file are shown below: 
 

Study Name:  study_0.stu 
Basic Summary Output 
Date:  07:29 AM, Thursday, January 16, 2003 
Application:  Compartmental 
Type of Calculation:  Solve 
------------------------------------------------------------------
---------------------- 
 
Computational Settings 
 
Integrator:  Rosenbrock 
Relative Integrator Error:  1.0000e-003  
------------------------------------------------------------------
---------------------- 
 
Values at t = 0.0 days 
 
ex1.bolus              1.040000e+008 
ex1.infusion           0.000000 
flux(0,1)              1.040000e+007 
flux(1,2)              0.000000 
flux(2,1)              1.040000e+007 
k(0,1)                 0.100000 
k(1,2)                 0.100000 
k(2,1)                 0.100000 
plasma                  - 
q1                     1.040000e+008 
q2                     0.000000 
s1                 52000.000000 
s1_res                  - 
s1_wres                 - 
t                      0.000000 
vol                 2000.000000 
------------------------------------------------------------------
---------------------- 
 
Calculated Sample Values and Data 
 
 
          t       plasma       Weight           s1      s1_wres 
 0.000e+000         -            -      5.200e+004         -    
 7.000e-003   4.678e+004         -      5.193e+004         -    
 4.200e-002   4.352e+004         -      5.157e+004         -    
 1.250e-001   4.254e+004         -      5.072e+004         -    
 2.500e-001   4.013e+004         -      4.948e+004         -    
 3.750e-001   3.622e+004         -      4.828e+004         -    
 5.000e-001   3.556e+004         -      4.711e+004         -    
 7.500e-001         -            -      4.489e+004         -    
 1.000e+000   2.819e+004         -      4.279e+004         -    
 1.450e+000         -            -      3.934e+004         -    
 1.725e+000         -            -      3.741e+004         -    
 2.000e+000   1.957e+004         -      3.561e+004         -    
 2.450e+000         -            -      3.290e+004         -    
 2.725e+000         -            -      3.139e+004         -    
 3.000e+000   1.440e+004         -      2.997e+004         -    
 3.450e+000         -            -      2.785e+004         -    
 3.725e+000         -            -      2.666e+004         -    
 4.000e+000   1.128e+004         -      2.554e+004         -    
 4.450e+000         -            -      2.386e+004         -    
 4.725e+000         -            -      2.292e+004         -    

Rev. 11/01/05 ReportsUS-12 2003 - 2005 University of Washington 



Using SAAM II Writing Reports 

 5.000e+000   8.081e+003         -      2.204e+004         -    
 5.450e+000         -            -      2.070e+004         -    
 5.725e+000         -            -      1.996e+004         -    
 6.000e+000   6.999e+003         -      1.925e+004         -    
 6.450e+000         -            -      1.819e+004         -    
 6.725e+000         -            -      1.759e+004         -    
 7.000e+000   5.653e+003         -      1.702e+004         -    
 7.450e+000         -            -      1.616e+004         -    
 7.725e+000         -            -      1.568e+004         -    
 8.000e+000   5.139e+003         -      1.522e+004         -    
 8.450e+000         -            -      1.453e+004         -    
 8.725e+000         -            -      1.413e+004         -    
 9.000e+000         -            -      1.376e+004         -    
 9.000e+000   4.210e+003         -      1.376e+004         -    
------------------------------------------------------------------
---------------------- 
 
Statistics 
 
No Statistics after a Solve 
------------------------------------------------------------------
---------------------- 
 
 

The first line of the file is simply the name of the study file. The next is the 
type of output, in this case, Basic. Next is the date followed by the SAAM II 
Application, in this case, Compartmental. Finally, the type of calculation 
which produced the output is given, in this case, Solve. 
 
The Computational settings provide the chosen integrator and the setting for 
the Relative Integrator Error.  
 
This is followed by the values at time zero. This information is the same as 
that in the Values window at time zero.  
 
The calculated sample values and data come next in a table. Notice the 
weights or weighted residuals are not given; this is because the calculation 
was a Solve and not a Fit. 
 
Values for s1 are given at all calculation points; this is why there are more  s1 
values here than for data. Remember the number of calculation points is set in 
the Computational Settings dialog box in the Min. Nr. Calculation 
Intervals box. 
 
This information can be cut from the text window and pasted into another 
application for you to prepare your report. 

 
c. Close the text file and return to study_0. 
 
 
 

6. Fit the model, and view the text file created. 
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a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar 

click Fit . 
 
b. Go to the folder where study_0 is located. In this folder, you will find the file 

study_0.txt. This file contains the following information (note the previous 
file has been over written): 

 
Study Name:  study_0.stu 
Basic Summary Output 
Date:  02:40 PM, Thursday, January 16, 2003 
Application:  Compartmental 
Type of Calculation:  Fit 
------------------------------------------------------------------
---------------------- 
 
Computational Settings 
 
Integrator:  Rosenbrock 
Relative Integrator Error:  1.0000e-003  
Variance Model:  Data, Relative 
Derivative:  Forward 
------------------------------------------------------------------
---------------------- 
 
Values at t = 0.0 days 
 
ex1.bolus              1.040000e+008 
ex1.infusion           0.000000 
flux(0,1)              3.039597e+007 
flux(1,2)              0.000000 
flux(2,1)              1.814980e+007 
k(0,1)                 0.292269 
k(1,2)                 0.283108 
k(2,1)                 0.174517 
plasma                  - 
q1                     1.040000e+008 
q2                     0.000000 
s1                 44754.732253 
s1_res                  - 
s1_wres                 - 
t                      0.000000 
vol                 2323.776610 
------------------------------------------------------------------
---------------------- 
 
Calculated Sample Values and Data 
 
 
          t       plasma       Weight           s1      s1_wres 
 0.000e+000         -            -      4.475e+004         -    
 7.000e-003   4.678e+004   4.104e-007   4.461e+004   1.391e+000 
 4.200e-002   4.352e+004   4.741e-007   4.389e+004  -2.519e-001 
 1.250e-001   4.254e+004   4.964e-007   4.223e+004   2.117e-001 
 2.500e-001   4.013e+004   5.578e-007   3.989e+004   1.772e-001 
 3.750e-001   3.622e+004   6.845e-007   3.770e+004  -1.225e+000 
 5.000e-001   3.556e+004   7.101e-007   3.566e+004  -8.650e-002 
 7.500e-001         -            -      3.200e+004         -    
 1.000e+000   2.819e+004   1.130e-006   2.880e+004  -6.469e-001 
 1.450e+000         -            -      2.405e+004         -    
 1.725e+000         -            -      2.166e+004         -    
 2.000e+000   1.957e+004   2.344e-006   1.960e+004  -4.317e-002 
 2.450e+000         -            -      1.680e+004         -    
 2.725e+000         -            -      1.537e+004         -    
 3.000e+000   1.440e+004   4.329e-006   1.412e+004   5.867e-001 
 3.450e+000         -            -      1.240e+004         -    
 3.725e+000         -            -      1.151e+004         -    
 4.000e+000   1.128e+004   7.061e-006   1.072e+004   1.494e+000 
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 4.450e+000         -            -      9.603e+003         -    
 4.725e+000         -            -      9.016e+003         -    
 5.000e+000   8.081e+003   1.375e-005   8.487e+003  -1.507e+000 
 5.450e+000         -            -      7.728e+003         -    
 5.725e+000         -            -      7.319e+003         -    
 6.000e+000   6.999e+003   1.833e-005   6.944e+003   2.355e-001 
 6.450e+000         -            -      6.395e+003         -    
 6.725e+000         -            -      6.093e+003         -    
 7.000e+000   5.653e+003   2.810e-005   5.813e+003  -8.504e-001 
 7.450e+000         -            -      5.396e+003         -    
 7.725e+000         -            -      5.162e+003         -    
 8.000e+000   5.139e+003   3.401e-005   4.943e+003   1.142e+000 
 8.450e+000         -            -      4.612e+003         -    
 8.725e+000         -            -      4.424e+003         -    
 9.000e+000         -            -      4.246e+003         -    
 9.000e+000   4.210e+003   5.067e-005   4.246e+003  -2.582e-001 
------------------------------------------------------------------
---------------------- 
 
Statistics 
 

Parameter/Variable      Value      Std.Dev. Coef. of Var.   95% Confidence Interval 
------------------    -------      --------  -------------    ----------------------- 
k(0,1)                0.29227  1.46155e-002  5.00071e+000       0.26010       0.32444 
k(1,2)                0.28311  7.51183e-002  2.65335e+001       0.11777       0.44844 
k(2,1)                0.17452  1.82636e-002  1.04652e+001       0.13432       0.21472 
vol                2323.77661  3.85619e+001  1.65945e+000    2238.90219    2408.65103 
 
 
          Objective      Scaled Data Variance 

s1 : plasma             1.336743e+001       1.113515e-001 
                       -------------- 
Total objective         1.336743e+001 
 
AIC                     7.935987e+000 
BIC                     8.053995e+000 
 
Number of Iterations Required to Fit: 5 
------------------------------------------------------------------
---------------------- 

 
This contains the same information as that following a Solve except 
information about the Fit and statistics is available. 

 
c. Close study_0.txt, and return to study_0.stu. 
 

Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
 
You will now repeat what you did above, only observe the Detailed output and set the 
File option to Add. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 

 
a. The file study_0.stu should appear in the file list; if it does not, find the folder 

where you put this tutorial. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 
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3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear on the Drawing Canvas 
as follows: 

 

 
 

 
4. Turning on the Save Results option. 
 

a. In the Compute menu, click Settings. The Computational Settings dialog 
box will open as shown below: 
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The bottom pane of the dialog box contains the Save Results to Text File 
check box. If this box is checked, the Level and File panes become active. 

 
b. Select Save Results to Text File. In the Level pane, select Detailed. In the 

File pane, select Add. The panes will appear as follows. 
 

 
 
c. Click Done. You will now produce more detailed information, and will 

produce a file each time you Solve or Fit. 
 

5. Solve the model, and view the text file created. 
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a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 
b. Go to the folder where study_0 is located. In this folder, you will find a file 

entitled study_0.txt. The contents of this file are shown below: 
 

Study Name:  study_0.stu 
Detailed Summary Output 
Date:  07:36 AM, Thursday, January 16, 2003 
Application:  Compartmental 
Type of Calculation:  Solve 
------------------------------------------------------------------
---------------------- 
 
Computational Settings 
 
Number of Calculation Intervals:  20 
Integrator:  Rosenbrock 
Relative Integrator Error:  1.0000e-003  
Maximum Number of Iterations: 20 
------------------------------------------------------------------
---------------------- 
 
Experiment Attributes 
 
Independent Variable: t (days) 
Start of Experiment: 0.0000e+000  
End of Experiment:   9.0000e+000  
------------------------------------------------------------------
---------------------- 
 
Parameter Values 
 
Parameter      Type Prior Value   New Value Lower Limit Upper Limit 
--------------- --- ----------- ----------- ----------- ----------
- 
k(0,1)          Adj  1.000e-001  1.000e-001  1.000e-002  1.000e+000 
k(1,2)          Adj  1.000e-001  1.000e-001  1.000e-002  1.000e+000 
k(2,1)          Adj  1.000e-001  1.000e-001  1.000e-002  1.000e+000 
vol             Adj  2.000e+003  2.000e+003  2.000e+002  2.000e+004 
------------------------------------------------------------------
---------------------- 
 
Values at t = 0.0 days 
 
ex1.bolus              1.040000e+008 
ex1.infusion           0.000000 
flux(0,1)              1.040000e+007 
flux(1,2)              0.000000 
flux(2,1)              1.040000e+007 
k(0,1)                 0.100000 
k(1,2)                 0.100000 
k(2,1)                 0.100000 
plasma                  - 
q1                     1.040000e+008 
q2                     0.000000 
s1                 52000.000000 
s1_res                  - 
s1_wres                 - 
t                      0.000000 
vol                 2000.000000 
------------------------------------------------------------------
---------------------- 
 
Calculated Sample Values and Data 
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          t       plasma       Weight           s1      s1_wres 
 0.000e+000         -            -      5.200e+004         -    
 7.000e-003   4.678e+004         -      5.193e+004         -    
 4.200e-002   4.352e+004         -      5.157e+004         -    
 1.250e-001   4.254e+004         -      5.072e+004         -    
 2.500e-001   4.013e+004         -      4.948e+004         -    
 3.750e-001   3.622e+004         -      4.828e+004         -    
 5.000e-001   3.556e+004         -      4.711e+004         -    
 7.500e-001         -            -      4.489e+004         -    
 1.000e+000   2.819e+004         -      4.279e+004         -    
 1.450e+000         -            -      3.934e+004         -    
 1.725e+000         -            -      3.741e+004         -    
 2.000e+000   1.957e+004         -      3.561e+004         -    
 2.450e+000         -            -      3.290e+004         -    
 2.725e+000         -            -      3.139e+004         -    
 3.000e+000   1.440e+004         -      2.997e+004         -    
 3.450e+000         -            -      2.785e+004         -    
 3.725e+000         -            -      2.666e+004         -    
 4.000e+000   1.128e+004         -      2.554e+004         -    
 4.450e+000         -            -      2.386e+004         -    
 4.725e+000         -            -      2.292e+004         -    
 5.000e+000   8.081e+003         -      2.204e+004         -    
 5.450e+000         -            -      2.070e+004         -    
 5.725e+000         -            -      1.996e+004         -    
 6.000e+000   6.999e+003         -      1.925e+004         -    
 6.450e+000         -            -      1.819e+004         -    
 6.725e+000         -            -      1.759e+004         -    
 7.000e+000   5.653e+003         -      1.702e+004         -    
 7.450e+000         -            -      1.616e+004         -    
 7.725e+000         -            -      1.568e+004         -    
 8.000e+000   5.139e+003         -      1.522e+004         -    
 8.450e+000         -            -      1.453e+004         -    
 8.725e+000         -            -      1.413e+004         -    
 9.000e+000         -            -      1.376e+004         -    
 9.000e+000   4.210e+003         -      1.376e+004         -    
------------------------------------------------------------------
---------------------- 
 
Statistics 
 
No Statistics after a Solve 
------------------------------------------------------------------
---------------------- 
 
Notes 
 
None 
------------------------------------------------------------------
---------------------- 

 

This file contains all of the information contained in the “Basic” option plus 
additional information. There is more information about the Computational 
Settings. The file contains the Experimental Attributes and the initial 
parameter values. Finally, at the very end, are the contents of the Notes 
window. In this case there are no notes. If you have information in the Notes 
window, it would appear here. 

 
c. Close the text file, and return to study_0. 

 
6. Fit the model, and view the text file created. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar 

click Fit . 
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b. Go to the folder where study_0 is located. In this folder, you will find a file 

entitled study_0.txt. and study_0_01.txt 
 

 
 

The file study_0_01 contains the information following the Fit. Each time you 
solve or fit, you will produce a file with a number such as “01” after it. If you 
are doing this several times, it is useful to keep track of the number using 
Notes. 
 
The contents of study_0_01 are shown  below. 

 
Study Name:  study_0.stu 
Detailed Summary Output 
Date:  07:38 AM, Thursday, January 16, 2003 
Application:  Compartmental 
Type of Calculation:  Fit 
------------------------------------------------------------------
---------------------- 
 
Computational Settings 
 
Number of Calculation Intervals:  20 
Integrator:  Rosenbrock 
Relative Integrator Error:  1.0000e-003  
Maximum Number of Iterations: 20 
Variance Model:  Data, Relative 
Derivative:  Forward 
------------------------------------------------------------------
---------------------- 
 
Experiment Attributes 
 
Independent Variable: t (days) 
Start of Experiment: 0.0000e+000  
End of Experiment:   9.0000e+000  
------------------------------------------------------------------
---------------------- 
 
Parameter Values 
 
Parameter      Type Prior Value   New Value Lower Limit Upper Limit 
--------------- --- ----------- ----------- ----------- ----------- 
k(0,1)          Adj  1.000e-001  2.923e-001  1.000e-002  1.000e+000 
k(1,2)          Adj  1.000e-001  2.831e-001  1.000e-002  1.000e+000 
k(2,1)          Adj  1.000e-001  1.745e-001  1.000e-002  1.000e+000 
vol             Adj  2.000e+003  2.324e+003  2.000e+002  2.000e+004 
------------------------------------------------------------------
---------------------- 
 
Values at t = 0.0 days 
 
ex1.bolus              1.040000e+008 
ex1.infusion           0.000000 
flux(0,1)              3.039597e+007 
flux(1,2)              0.000000 
flux(2,1)              1.814980e+007 
k(0,1)                 0.292269 
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k(1,2)                 0.283108 
k(2,1)                 0.174517 
plasma                  - 
q1                     1.040000e+008 
q2                     0.000000 
s1                 44754.732253 
s1_res                  - 
s1_wres                 - 
t                      0.000000 
vol                 2323.776610 
------------------------------------------------------------------
---------------------- 
 
Calculated Sample Values and Data 
 
 
          t       plasma       Weight           s1      s1_wres 
 0.000e+000         -            -      4.475e+004         -    
 7.000e-003   4.678e+004   4.104e-007   4.461e+004   1.391e+000 
 4.200e-002   4.352e+004   4.741e-007   4.389e+004  -2.519e-001 
 1.250e-001   4.254e+004   4.964e-007   4.223e+004   2.117e-001 
 2.500e-001   4.013e+004   5.578e-007   3.989e+004   1.772e-001 
 3.750e-001   3.622e+004   6.845e-007   3.770e+004  -1.225e+000 
 5.000e-001   3.556e+004   7.101e-007   3.566e+004  -8.650e-002 
 7.500e-001         -            -      3.200e+004         -    
 1.000e+000   2.819e+004   1.130e-006   2.880e+004  -6.469e-001 
 1.450e+000         -            -      2.405e+004         -    
 1.725e+000         -            -      2.166e+004         -    
 2.000e+000   1.957e+004   2.344e-006   1.960e+004  -4.317e-002 
 2.450e+000         -            -      1.680e+004         -    
 2.725e+000         -            -      1.537e+004         -    
 3.000e+000   1.440e+004   4.329e-006   1.412e+004   5.867e-001 
 3.450e+000         -            -      1.240e+004         -    
 3.725e+000         -            -      1.151e+004         -    
 4.000e+000   1.128e+004   7.061e-006   1.072e+004   1.494e+000 
 4.450e+000         -            -      9.603e+003         -    
 4.725e+000         -            -      9.016e+003         -    
 5.000e+000   8.081e+003   1.375e-005   8.487e+003  -1.507e+000 
 5.450e+000         -            -      7.728e+003         -    
 5.725e+000         -            -      7.319e+003         -    
 6.000e+000   6.999e+003   1.833e-005   6.944e+003   2.355e-001 
 6.450e+000         -            -      6.395e+003         -    
 6.725e+000         -            -      6.093e+003         -    
 7.000e+000   5.653e+003   2.810e-005   5.813e+003  -8.504e-001 
 7.450e+000         -            -      5.396e+003         -    
 7.725e+000         -            -      5.162e+003         -    
 8.000e+000   5.139e+003   3.401e-005   4.943e+003   1.142e+000 
 8.450e+000         -            -      4.612e+003         -    
 8.725e+000         -            -      4.424e+003         -    
 9.000e+000         -            -      4.246e+003         -    
 9.000e+000   4.210e+003   5.067e-005   4.246e+003  -2.582e-001 
------------------------------------------------------------------
---------------------- 
 
Statistics 
 
Parameter/Variable      Value      Std.Dev. Coef. of Var.   95% Confidence Interval 
------------------    -------      --------  -------------    ----------------------- 
k(0,1)                0.29227  1.46155e-002  5.00071e+000       0.26010       0.32444 
k(1,2)                0.28311  7.51183e-002  2.65335e+001       0.11777       0.44844 
k(2,1)                0.17452  1.82636e-002  1.04652e+001       0.13432       0.21472 
vol                2323.77661  3.85619e+001  1.65945e+000    2238.90219    2408.65103 
 
                          Objective      Scaled Data Variance 
s1 : plasma             1.336743e+001       1.113515e-001 
                       -------------- 
Total objective         1.336743e+001 
 
AIC                     7.935987e+000 
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BIC                     8.053995e+000 
 
Number of Iterations Required to Fit: 5 
------------------------------------------------------------------
---------------------- 
 
Notes 
 
None 
------------------------------------------------------------------
---------------------- 

 

The information parallels that following the Solve except now information on 
the Fit is available. This includes the weights and weighted residuals, and the 
information from the Statistics window. It also includes the number of 
iterations required to Fit the data. 
 
If you had information in the Notes window, it would appear at the end of this 
file. 

 
c. Close the text file, and return to study_0.stu. 
 
This information can be cut from the text window and pasted into another 
application for you to prepare your report. 
 

Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
 
 
You will now repeat what you did above, only observe the All output and set the File 
option to Add. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Open the SAAM II Compartmental study file study_0. 

 
a. The file study_0.stu should appear in the file list; if it does not, find the folder 

where you put this tutorial. 
 

b. In the File menu, click Open. The SAAM II Compartmental main window 
will appear as shown below: 
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3. View the model and the experiment on the model. In the SAAM II Toolbox, click 
Experiment. The model of the experiment will appear on the Drawing Canvas 
as follows: 

 

 
 

 
 

4. Turning on the Save Results option. 
 

a. In the Compute menu, click Settings. The Computational Settings dialog 
box will open as shown below: 
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The bottom pane of the dialog box contains the Save Results to Text File 
check box. If this box is checked, the Level and File panes become active. 

 
b. Select Save Results to Text File. In the Level pane, select All. In the File 

pane, select Add.  
 
c. Click Done. You will now produce more detailed information, and will 

produce a file each time you Solve or Fit. 
 

5. Solve the model, and view the text file created. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 
b. Go to the folder where study_0 is located. In this folder, you will find a file 

entitled study_0.txt. The contents of this file are shown below: 
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Study Name:  study_0.stu 
Model and Detailed Summary Output 
Date:  08:08 AM, Thursday, January 16, 2003 
Application:  Compartmental 
Type of Calculation:  Solve 
------------------------------------------------------------------
---------------------- 
 
Computational Settings 
 
Number of Calculation Intervals:  20 
Integrator:  Rosenbrock 
Relative Integrator Error:  1.0000e-003  
Maximum Number of Iterations: 20 
------------------------------------------------------------------
---------------------- 
 
Experiment Attributes 
 
Independent Variable: t (days) 
Start of Experiment: 0.0000e+000  
End of Experiment:   9.0000e+000  
------------------------------------------------------------------
---------------------- 
 
Model Equations 
 
flux(1,2) = k(1,2) * q2 
flux(2,1) = k(2,1) * q1 
flux(0,1) = k(0,1) * q1 
ex1.bolus = 0.0 
ex1.infusion = 0.0 
s1 = q1/vol 
q1' = + k(1,2)*q2 - k(2,1)*q1 - k(0,1)*q1 + ex1 
q2' = - k(1,2)*q2 + k(2,1)*q1 
------------------------------------------------------------------
---------------------- 
 
Data 
 
DATA 
(FSD 0.1) 
t  plasma 
0.007 46780 
0.042 43522 
0.125 42535 
0.25 40125 
0.375 36221 
0.5  35562 
1.0  28194 
2.0  19573 
3.0  14403 
4.0  11278 
5.0  8081 
6.0  6999 
7.0  5653 
8.0  5139 
9.0  4210 
END 
------------------------------------------------------------------
---------------------- 
 
Exogenous Inputs 
 
Name: ex1 
Experiment: tracer 
Input to: q1 
 
Type          Input     Constant        Start         Stop     
Interval   Number 
-------- ------------ ------------ ------------ ------------ -----
------- ------ 
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Bolus     1.0400e+008         -     0.0000e+000         -            
-         - 
------------------------------------------------------------------
---------------------- 
 
Change Conditions 
 
No Change Conditions 
------------------------------------------------------------------
---------------------- 
 
General Model Information 
 
Compartment Numbers in Model:   1, 2 
 
 
No Delays 
 
 
Experiments: 
 
Name                           Type       Suffix 
------------------------------ ---------- ------ 
tracer                         Exogenous      -  
------------------------------------------------------------------
---------------------- 
 
Parameter Values 
 
Parameter      Type Prior Value   New Value Lower Limit Upper Limit 
--------------- --- ----------- ----------- ----------- ----------- 
k(0,1)          Adj  1.000e-001  1.000e-001  1.000e-002  1.000e+000 
k(1,2)          Adj  1.000e-001  1.000e-001  1.000e-002  1.000e+000 
k(2,1)          Adj  1.000e-001  1.000e-001  1.000e-002  1.000e+000 
vol             Adj  2.000e+003  2.000e+003  2.000e+002  2.000e+004 
---------------------------------------------------------------------------------------- 
 
Values at t = 0.0 days 
 
ex1.bolus              1.040000e+008 
ex1.infusion           0.000000 
flux(0,1)              1.040000e+007 
flux(1,2)              0.000000 
flux(2,1)              1.040000e+007 
k(0,1)                 0.100000 
k(1,2)                 0.100000 
k(2,1)                 0.100000 
plasma                  - 
q1                     1.040000e+008 
q2                     0.000000 
s1                 52000.000000 
s1_res                  - 
s1_wres                 - 
t                      0.000000 
vol                 2000.000000 
------------------------------------------------------------------
---------------------- 
 
Calculated Sample Values and Data 
 
 
          t       plasma       Weight           s1      s1_wres 
 0.000e+000         -            -      5.200e+004         -    
 7.000e-003   4.678e+004         -      5.193e+004         -    
 4.200e-002   4.352e+004         -      5.157e+004         -    
 1.250e-001   4.254e+004         -      5.072e+004         -    
 2.500e-001   4.013e+004         -      4.948e+004         -    
 3.750e-001   3.622e+004         -      4.828e+004         -    
 5.000e-001   3.556e+004         -      4.711e+004         -    
 7.500e-001         -            -      4.489e+004         -    
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 1.000e+000   2.819e+004         -      4.279e+004         -    
 1.450e+000         -            -      3.934e+004         -    
 1.725e+000         -            -      3.741e+004         -    
 2.000e+000   1.957e+004         -      3.561e+004         -    
 2.450e+000         -            -      3.290e+004         -    
 2.725e+000         -            -      3.139e+004         -    
 3.000e+000   1.440e+004         -      2.997e+004         -    
 3.450e+000         -            -      2.785e+004         -    
 3.725e+000         -            -      2.666e+004         -    
 4.000e+000   1.128e+004         -      2.554e+004         -    
 4.450e+000         -            -      2.386e+004         -    
 4.725e+000         -            -      2.292e+004         -    
 5.000e+000   8.081e+003         -      2.204e+004         -    
 5.450e+000         -            -      2.070e+004         -    
 5.725e+000         -            -      1.996e+004         -    
 6.000e+000   6.999e+003         -      1.925e+004         -    
 6.450e+000         -            -      1.819e+004         -    
 6.725e+000         -            -      1.759e+004         -    
 7.000e+000   5.653e+003         -      1.702e+004         -    
 7.450e+000         -            -      1.616e+004         -    
 7.725e+000         -            -      1.568e+004         -    
 8.000e+000   5.139e+003         -      1.522e+004         -    
 8.450e+000         -            -      1.453e+004         -    
 8.725e+000         -            -      1.413e+004         -    
 9.000e+000         -            -      1.376e+004         -    
 9.000e+000   4.210e+003         -      1.376e+004         -    
------------------------------------------------------------------
---------------------- 
 
Statistics 
 
No Statistics after a Solve 
------------------------------------------------------------------
---------------------- 
 
Notes 
 
None 
------------------------------------------------------------------
---------------------- 

 

This file contains all of the information contained in the “Detailed” option 
plus additional information. The model equations (that appear in the 
Equations Read-Only window) are included. The data are also included as is 
information about the input and model (number of compartments). 

 
c. Close the text file, and return to study_0. 

 
6. Fit the model, and view the text file created. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar 

click Fit . 
 
b. Go to the folder where study_0 is located. In this folder, you will find a file 

entitled study_0.txt. and study_0_01.txt 
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The file study_0_01 contains the information following the Fit. Each time you 
solve or fit, you will produce a file with a number such as “01” after it. If you 
are doing this several times, it is useful to keep track of the number using 
Notes. 
 
The contents of study_0_01 are shown  below. 

 
Study Name:  study_0.stu 
Model and Detailed Summary Output 
Date:  08:08 AM, Thursday, January 16, 2003 
Application:  Compartmental 
Type of Calculation:  Fit 
------------------------------------------------------------------
---------------------- 
 
Computational Settings 
 
Number of Calculation Intervals:  20 
Integrator:  Rosenbrock 
Relative Integrator Error:  1.0000e-003  
Maximum Number of Iterations: 20 
Variance Model:  Data, Relative 
Derivative:  Forward 
------------------------------------------------------------------
---------------------- 
 
Experiment Attributes 
 
Independent Variable: t (days) 
Start of Experiment: 0.0000e+000  
End of Experiment:   9.0000e+000  
------------------------------------------------------------------
---------------------- 
 
Model Equations 
 
flux(1,2) = k(1,2) * q2 
flux(2,1) = k(2,1) * q1 
flux(0,1) = k(0,1) * q1 
ex1.bolus = 0.0 
ex1.infusion = 0.0 
s1 = q1/vol 
q1' = + k(1,2)*q2 - k(2,1)*q1 - k(0,1)*q1 + ex1 
q2' = - k(1,2)*q2 + k(2,1)*q1 
------------------------------------------------------------------
---------------------- 
 
Data 
 
DATA 
(FSD 0.1) 
t plasma 
0.007 46780 
0.042 43522 
0.125 42535 
0.25 40125 
0.375 36221 
0.5 35562 
1.0 28194 
2.0 19573 
3.0 14403 
4.0 11278 
5.0 8081 
6.0 6999 
7.0 5653 
8.0 5139 
9.0 4210 
END 
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------------------------------------------------------------------
---------------------- 
 
Exogenous Inputs 
 
Name: ex1 
Experiment: tracer 
Input to: q1 
 
Type          Input     Constant        Start         Stop     
Interval   Number 
-------- ------------ ------------ ------------ ------------ -----
------- ------ 
Bolus     1.0400e+008         -     0.0000e+000         -            
-         - 
------------------------------------------------------------------
---------------------- 
 
Change Conditions 
 
No Change Conditions 
------------------------------------------------------------------
---------------------- 
 
General Model Information 
 
Compartment Numbers in Model:   1, 2 
 
 
No Delays 
 
 
Experiments: 
 
Name                           Type       Suffix 
------------------------------ ---------- ------ 
tracer                         Exogenous      -  
------------------------------------------------------------------
---------------------- 
 
Parameter Values 
 
Parameter      Type Prior Value   New Value Lower Limit Upper Limit 
--------------- --- ----------- ----------- ----------- ----------- 
k(0,1)          Adj  1.000e-001  2.923e-001  1.000e-002  1.000e+000 
k(1,2)          Adj  1.000e-001  2.831e-001  1.000e-002  1.000e+000 
k(2,1)          Adj  1.000e-001  1.745e-001  1.000e-002  1.000e+000 
vol             Adj  2.000e+003  2.324e+003  2.000e+002  2.000e+004 
------------------------------------------------------------------
---------------------- 
 
Values at t = 0.0 days 
 
ex1.bolus              1.040000e+008 
ex1.infusion           0.000000 
flux(0,1)              3.039597e+007 
flux(1,2)              0.000000 
flux(2,1)              1.814980e+007 
k(0,1)                 0.292269 
k(1,2)                 0.283108 
k(2,1)                 0.174517 
plasma                  - 
q1                     1.040000e+008 
q2                     0.000000 
s1                 44754.732253 
s1_res                  - 
s1_wres                 - 
t                      0.000000 
vol                 2323.776610 
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------------------------------------------------------------------
---------------------- 
 
Calculated Sample Values and Data 
 
 
          t       plasma       Weight           s1      s1_wres 
 0.000e+000         -            -      4.475e+004         -    
 7.000e-003   4.678e+004   4.104e-007   4.461e+004   1.391e+000 
 4.200e-002   4.352e+004   4.741e-007   4.389e+004  -2.519e-001 
 1.250e-001   4.254e+004   4.964e-007   4.223e+004   2.117e-001 
 2.500e-001   4.013e+004   5.578e-007   3.989e+004   1.772e-001 
 3.750e-001   3.622e+004   6.845e-007   3.770e+004  -1.225e+000 
 5.000e-001   3.556e+004   7.101e-007   3.566e+004  -8.650e-002 
 7.500e-001         -            -      3.200e+004         -    
 1.000e+000   2.819e+004   1.130e-006   2.880e+004  -6.469e-001 
 1.450e+000         -            -      2.405e+004         -    
 1.725e+000         -            -      2.166e+004         -    
 2.000e+000   1.957e+004   2.344e-006   1.960e+004  -4.317e-002 
 2.450e+000         -            -      1.680e+004         -    
 2.725e+000         -            -      1.537e+004         -    
 3.000e+000   1.440e+004   4.329e-006   1.412e+004   5.867e-001 
 3.450e+000         -            -      1.240e+004         -    
 3.725e+000         -            -      1.151e+004         -    
 4.000e+000   1.128e+004   7.061e-006   1.072e+004   1.494e+000 
 4.450e+000         -            -      9.603e+003         -    
 4.725e+000         -            -      9.016e+003         -    
 5.000e+000   8.081e+003   1.375e-005   8.487e+003  -1.507e+000 
 5.450e+000         -            -      7.728e+003         -    
 5.725e+000         -            -      7.319e+003         -    
 6.000e+000   6.999e+003   1.833e-005   6.944e+003   2.355e-001 
 6.450e+000         -            -      6.395e+003         -    
 6.725e+000         -            -      6.093e+003         -    
 7.000e+000   5.653e+003   2.810e-005   5.813e+003  -8.504e-001 
 7.450e+000         -            -      5.396e+003         -    
 7.725e+000         -            -      5.162e+003         -    
 8.000e+000   5.139e+003   3.401e-005   4.943e+003   1.142e+000 
 8.450e+000         -            -      4.612e+003         -    
 8.725e+000         -            -      4.424e+003         -    
 9.000e+000         -            -      4.246e+003         -    
 9.000e+000   4.210e+003   5.067e-005   4.246e+003  -2.582e-001 
------------------------------------------------------------------
---------------------- 
 
Statistics 
 
Parameter/Variable      Value      Std.Dev. Coef. of Var.   95% Confidence Interval 
------------------    -------      --------  -------------    ----------------------- 
k(0,1)                0.29227  1.46155e-002  5.00071e+000       0.26010       0.32444 
k(1,2)                0.28311  7.51183e-002  2.65335e+001       0.11777       0.44844 
k(2,1)                0.17452  1.82636e-002  1.04652e+001       0.13432       0.21472 
vol                2323.77661  3.85619e+001  1.65945e+000    2238.90219    2408.65103 
 
                          Objective      Scaled Data Variance 
s1 : plasma             1.336743e+001       1.113515e-001 
                       -------------- 
Total objective         1.336743e+001 
 
AIC                     7.935987e+000 
BIC                     8.053995e+000 
 
Number of Iterations Required to Fit: 5 
------------------------------------------------------------------
---------------------- 
 
Notes 
 
None 
------------------------------------------------------------------
---------------------- 
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The information parallels that following the Solve except now information on 
the Fit is available. This includes the weights and weighted residuals, and the 
information from the Statistics window. It also includes the number of 
iterations required to Fit the data. 

 
c. Close the text file and return to study_0. 
 
This information can be cut from the text window and pasted into another 
application for you to prepare your report. 
 

Quit the SAAM II Compartmental application. Do not save the changes to study_0. 
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